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Sažetak 

 

Između Novog Vinodolskog i Karlobaga (dionica državne ceste D8) učestalo dolazi do 

zatvaranja prometa uslijed jakih udara vjetra (bure) za prvu skupinu vozila (autobusi na kat, 

vozila s kamp-prikolicom i motocikli). Zatvaranje ceste između Novog Vinodolskog i 

Karlobaga dešava se kada izmjereni sekundni udari vjetra na Balinskom vijaduktu premaše 25 

m/s u slučaju mokrog kolnika i 30,6 m/s u slučaju suhog kolnika (prema važećem pravilniku 

Hrvatskih cesta).  

 

U ovom radu provedena je analiza prostorne raspodjele brzine vjetra na dionici ceste između 

Novog Vinodolskog i Karlobaga temeljem modula „Wind effect“, dostupnog u sklopu 

platforme QGIS, te brzine i smjera vjetra iz numeričkog atmosferskog modela Aladin-Hr u 

razdoblju 1998.-2001. U QGIS sučelju je za proračune brzine uzduž analizirane cestovne 

dionice korištena prostorna rezolucija podataka od 25m, a podaci o brzini i smjeru vjetra iz 

modela Aladin-Hr imaju prostornu rezoluciju od 4km i vremensku rezoluciju od 3h.  

 

Rezultati provedenih proračuna pokazali su da je moguće provesti zatvaranje ceste po 

pojedinim segmentima umjesto zatvaranja cjelokupne dionice između Novog Vinodolskog i 

Karlobaga.   
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Summary 

 

Between Novi Vinodolski and Karlobag (section of state road D8) traffic is often closed due 

to strong gusts of wind (bura) for the first group of vehicles (double-decker buses, vehicles 

with caravans and motorcycles). The closure of the road between Novi Vinodolski and 

Karlobag occurs when the measured second wind gusts on the Balin Viaduct exceed 24 m/s 

in the case of wet pavement and 30.6 m/s in the case of dry pavement (according to the 

current rulebook of Hrvatske Ceste).  

 

In this paper, an analysis of the spatial distribution of wind speed on the road section between 

Novi Vinodolski and Karlobag was carried out based on the „Wind effect“ module, avaliable 

as part of the QGIS platform, and wind speed and direction from the numerical atmospheric 

model Aladin-Hr in the period 1998-2001. In the QGIS interface, a spatial dana resolution of 

25m was used for speed calculations along the analyzed road section, while the dana on wind 

speed and direction from the Aladin-Hr model have a spatial resolution of 4 km and a temporal 

resoulution of 3h. 

 

The results of the calulculations showed that it is possible to close the road in invidual segments 

instead of closing the entire section between Novi Vinodolski and Karlobag.  
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1. UVOD 
 

Situacije u kojima je promet zatvoren generiraju  neposredni i posredni društveni trošak kroz 

izgubljeno vrijeme, nemogućnost obavljanja poslova koji zahtijevaju prolazak tom dionicom, 

negativan utjecaj na turizam i slično. Iz tog razloga potrebno je utvrditi može li se kroz doradu 

protokola za zatvaranje prometnice na pojedinim dijelovima prometnice smanjiti ukupno 

vrijeme u godini u kojem je prometnica zatvorena. 

 

Protokol zatvaranja cjelokupne dionice je sljedeći. Dežurni službenik u društvu kapitala 

(privatne firme) prati prognoze o brzini i smjeru vjetra (model Aladin-Hr za prognozu vjetra 

+72h). Ukoliko prognoza ukazuje na moguću pojavu vrlo jakog i olujnog vjetra (primarno 

bure) prate se mjereni jednosekundni udari vjetra na lokacijama Balinski vijadukt (meteo 

postaja od HC, prati se i temperatura i stanje kolnika, 24km od Senja). Prema potrebi na teren 

se šalje ophodar koji s ručnim anemometrom mjeri udare vjetra.  

 

Prema tablici iz Pravilnika o obavljanja prometa u zimskim uvjetima donosi se odluka o 

zatvaranju ceste. Primjerice, za autobuse, teretna i osobna vozila maksimalni dozvoljeni 

sekundni udari vjetra su 110 km/h pri uvjetima suhog kolnika, 90 km/h pri uvjetima mokrog 

kolnika, te 60 km/h pri uvjetima zaleđenog kolnika. 
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2. PODLOGE – BRZINE I SMJER VJETRA IZ MODELA ALADIN - HR 
 

U Državnom hidrometeorološkom zavodu Hrvatske je trenutno operativno funkcionalan 

atmosferski model Aladin-Hr u hidrostatskoj verziji baziranoj na primitivnim jednadžbama sa 

numeričkom implementacijom razvijenom u kooperaciji sa nekoliko nacionalnih 

meteoroloških institucija. Model proizlazi iz globalnog ARPEGE (Action de Recherche Petite 

Echelle Grande Echelle) modela od Meteo-France (Courtier i sur., 1991.), sa kojime izmjenjuje 

i podatke o većini fizikalnih relevantnih parametara potrebnih za definiranje rubnih uvjeta 

(Cordoneanu i Geleyn, 1998.). Model Aladin koristi prostornu rezoluciju dostatnu za 

razlučivanje intenzivnih izmjena u smjerovima i intenzitetima prevladavajućih vjetrova na 

području Jadrana (Brzović i Strelec-Mahović, 1999.; Ivatek-Sahdan i Tudor, 2004.). 

 

Na slici 2.1 prikazane su  točke ekstrakcije rezultata brzine i smjera vjetra iz numeričkog 

atmosferskog modela Aladin-HR sa prostornom rezolucijom 4km i vremenskom rezolucijom 

rezultata od 3 sata (za razdoblje 1998.-2001.). Točka 1 predstavlja poziciju proračunske ćelije 

numeričkog modela Aladin-Hr u kojoj se nalazi i Balinski vijadukt. Preostale točke (2, 3, 4) 

odabrane su za potrebe definiranja korelacijskih odnosa brzine i smjera vjetra u zoni zaobalja 

i na poziciji točke 1, te definiranja rubnih uvjeta smjera vjetra za uspostavljeni model prostorne 

raspodjele brzine vjetra u QGIS sučelju.  

 

Na slikama 2.2 i 2.3 prikazane su komparativne vremenske serije brzine i smjera vjetra prema 

rezultatima numeričkog atmosferskog modela Aladin-Hr za razdoblje 1.1.1998.-1.1.2002. (4 

km prostorna rezolucija i 3 satna vremenska rezolucija podataka) za poziciju točaka 1, 2, 3 i 4.  

 

 
Slika 2.1 Proračunska mreža modela Aladin-Hr (prostorna rezolucija 4km za 1991.-2001.) 

na Google podlozi i proračunske ćelije 1, 2, 3 i 4 sa kojih se ekstrahiraju podaci o brzini i 

smjeru vjetra 

1 (B. vijadukt) 

2 

3 

4 
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Slika 2.2 Komparativne vremenske serije brzine vjetra prema rezultatima numeričkog 

atmosferskog modela Aladin-Hr za razdoblje 1.1.1998.-1.1.2002. (4 km prostorna rezolucija 

i 3 satna vremenska rezolucija podataka), za pozicije točaka 1 (Balinski vijadukt), 2, 3 i 4 

(zaobalje) 
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Slika 2.3 Slika 2.3 Vremenske serije smjera vjetra prema rezultatima numeričkog 

atmosferskog modela Aladin-Hr za razdoblje 1.1.1998.-1.1.2002. (4 km prostorna rezolucija 

i 3 satna vremenska rezolucija podataka), za poziciju točke 1 (Balinski vijadukt) 

 

U narednom koraku definira se linearna korelacijska veze između smjera vjetra na točkama 1 

(Balinski vijadukt) i točaka 2, 3, 4 (zaobalje - unutrašnjost). Iz cjelokupnog seta podataka za 

korelacijske odnose koriste se samo oni u kojima brzina vjetra iz modela Aladin-HR premašuje 

vrijednost sekundnog udara vjetra od 25 m/s na poziciji Balinskog mosta - točka 1.  

 

Potrebno je napomenuti da su izlazni podaci iz modela Aldin-HR trosatni srednjaci brzine i 

smjera vjetra (slika 2.2), a udari vjetra su jednosekundne vrijednosti. Iz prikazanog dijagrama 

sa slike 2.4 mogu se očitati koeficijenti uvećanja, sa trosatnog u jednosatnu vrijednost Vsatni = 

1/0,93* Vtrosatni, te nakon toga iz jednosatnog u sekundni Vsekundni = 1,55* Vsatni.  
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Nadalje, podaci iz modela Aladin-Hr odnose se na visinu 10 m iznad terena, a što za potrebe 

daljnjih proračuna treba svesti na razinu na kojoj se kreću vozila (usvojeno 2m iznad terena). 

Može se koristiti empirička jednadžba raspodjele brzine u površinskom graničnom sloju (V2m 

= V10*(2/10)0,2 ; V2 - brzina vjetra na visini 2m nad terenom za more; V10 - brzina vjetra na 

10m nad terenom iz modela Aladin-HR).  

 

Prema tome, brzina sekundnog udara vjetra od 25 m/s odgovara trosatnoj brzini vjetra od 19 

m/s. Stoga se iz cjelokupnog seta podataka za korelacijske odnose koriste samo oni podaci u 

kojima trosatna brzina vjetra iz modela Aladin-HR premašuje vrijednost 19 m/s.    

 

 

Slika 2.4 Faktor mahovitosti vjetra CG3600(zm,t) za t-sekundni udar na visini zm = 10 m kad 

je poznata srednja satna brzina vjetra 𝑈3600[𝑠](𝑧𝑚) na visini zm i faktor mahovitosti vjetra 

CG
600(zm,t) za t-sekundni udar na visini zm = 10 m kad je poznata 10-minutna srednja brzina 

vjetra 𝑈600[𝑠](𝑧𝑚) na visini zm; sve za standardni teren na kopnu zo=0,05 m 

 

Na slici 2.5 prikazani su odnosi smjera vjetra na poziciji točke 1 (Balinski vijadukt), sa 

smjerovima vjetra na točkama 2, 3, i 4 (zaobalje), uz usvojeni uvjet premašenja sekundnog 

udara vjetra od 25 m/s na poziciji točke 1. Iz izdvojenog skupa podataka može se zaključiti da 

se smjerovi vjetra na poziciji Balinskog vijadukta pri postavljenom uvjetu premašenja 

sekundnog udara vjetra od 25 m/s (19 m/s u slučaju trosatnog srednjaka) pojavljuju u rasponu 

od 180 do 290. Sa druge strane, na poziciji točke 2 raspored smjerova za iste situacije se proteže 

od 350 do 580, na poziciji točke 3 od 220 do 380, te na poziciji točke 4 od 30 do 280. 
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Slika 2.5 Odnosi smjera vjetra za točku 1 (Balinski vijadukt) i 2, 3, 4 (zaobalje) temeljem 

podataka iz modela Aladin-Hr za razdoblje 1.1.1998. – 1.1.2002. uz postavljeno ograničenje 

da trosatna brzina vjetra na poziciji Balinskog vijadukta  bude veća od 19 m/s 

 

U kasnije korištenom modulu „Wind effect“, u okviru QGIS sučelja, za cijelu prostornu 

domenu definira se homogeni smjer djelovanja vjetra koji će rezultirati djelovanjem vjetra na 

poziciji Balinskog mosta u rasponu smjerova 180 – 290. Stoga se temeljem prethodno dobivenih 

rezultata u „Wind effect“ modulu (QGIS) koristi homogeno polje smjera vjetra u rasponu od 

50 do 550, sa korakom od 50.  
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3. USPOSTAVA MODELA PROSTORNE RASPODJELE VJETRA U QGIS 

SUČELJU 
 

U nastavku su prikazani koraci uspostave modela u QGIS sučelju temeljem kojeg se 

proračunava prostorna raspodjela brzine vjetra s prostorom rezolucijom podataka od 25m. 

Proračunom se dobivaju relativni odnosi brzina u odnosu na proizvoljno definiranu referentnu 

poziciju.  

3.1.Početne postavke sučelja i uvlačenje osnovnih podloga 

 

Postavljamo sloj HTRS umjesno zadanog WGS 84 (EPSG: 4326). Lijevi klik na simbol 

globusa sa tekstom EPSG: 4326 u donjem desnom dijelu ekrana.  

  

 
Slika 3.1 Postavljanje novog referentnog koordinatnog sustava 
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U novootvoreni prozor u prvo polje „Filter“ upisati HTRS, a iz dolje ponuđenog menija 

odabrati HTRS / Croatia TM EPSG:3765 → OK. 

 

 
Slika 3.2 Postavljanje HTRS96 / Croatia TM EPSG 3765 referentnog koordinatnog sustava 

 

Za uvlačenje grafičke podloge „OpenStreetMaps“ u gornjem lijevom prozoru „Browser“ 

pozicionirati se na XYZ Tiles → OpenStreetMap → desni klik → Add Layer to project  

 

 
Slika 3.3 Uvlačenje „OpenStreetMaps“ sloja (layera) 

Sada je taj sloj uvučen u donji lijevi prozor „Layers“. Uvećavamo na područje RH. 
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Slika 3.4 Uvećavanje i postavljanje prozora na područje RH 
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Uvlačenje novog sloja (layera), u ovom slučaju rastera sa geodetskim visinama terena u 

prostornoj rezoluciji 25m x 25m, obavlja se pritiskom na ikonu „Open data source Manager“, 

te izborom „Raster“. Nakon toga, pritiskom na gumb sa desne strane pored polja „Source“ 

otvara se preglednik za dohvaćanje odgovarajuće datoteke. Odabiremo odgovarajuću datoteku 

„EU_DEM_RH_HTRS96.tiff“. Open→ Add → Close. 

 

 
 

 
Slika 3.5 i Slika 3.6 Uvlačenje rasterskog sloja RH prostorne rezolucije 25m x 25m 
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Nakon provedbe navedenog postupka pojavljuje se dodatni rasterski sloj. Ukoliko želimo da 

se prikazani raster pojavljuju u spektru potrebno je sljedeće: u prozoru „Layers“ desni klik na 

rasterski sloj → Properties  → Symbology. U polju „Render type“ odabrati „Singleband 

pseudocolor“, u polju „Color ramp“ odabrati Invert color ramp, Apply → OK. 

 

 
 

 
Slika 3.7 i Slika 3.8 Dodavanje spektralnog izgleda rasteru 
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Slika 3.9 Rasterski visinski sloj cijele RH u spektralnom izgledu („DEM“) 

Sada uvlačimo novi sloj (layer), u ovom slučaju vektorski linijski sloj s kategoriziranim 

prometnicama u RH. Pritiskom na ikonu „Open data source Manager“, te izborom „Vector“. 

Nakon toga, pritiskom na gumb sa desne strane pored polja „Source“ otvara se preglednik za 

dohvaćanje odgovarajuće datoteke. Odabiremo odgovarajuću datoteku „Cestovni promet.shp“. 

Add → Close. 

 

 
Slika 3.10 Uvlačenje vektorskog linijskog sloja „Cestovni promet“ 
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Ponovno se može provesti već prethodno navedeni postupak za prezentaciju elemenata 

pojedinog sloja u različitim bojama. Desni klik na vektorski sloj s prometnicama u lijevom 

donjem prozoru „layers“ → Properties  → Symbology. U prvom polju biramo „Categorized“ a 

u polju „Value“ biramo „fclas“ (klasa ceste). Stisnemo na donji gumb „Classify“. Apply → 

OK. U prozoru Layers isključimo kvačice za sve kategorije ceste osim željene. Za prometnicu 

D8 to je „primary“. 

 

 
Slika 3.11 Klasifikacija vektorskog sloja „Cestovni promet“ po klasama ceste 
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Sada je potrebno napraviti-kreirati vektorski poligonski sloj koji pokriva samo područje na 

kojem se nalazi dionice ceste D8 od Crikvenice do Karlobaga. 

 

Layer → Create Layer → New shape file layer 

 

Nakon otvaranja kartice za definiranje novog vektorskog sloja, pritiskom  na gumb sa desne 

strane polja „File Name“ odabiremo lokaciju pohrane datoteke vektorskog sloja i njegovo ime 

(npr. „Poligon_D8“). U polju „Geometry type“ odabiremo „Polygon“, a u polju ispod geodetski 

CSR sloj (u našem slučaju HTRS / Croatia TM). Polja „New Field“ i „Field list“ trenutno nam 

nisu interesantna. Karticu zatvaramo sa OK. Formiran je novi vektorski poligonski sloj 

„Poligon_D8.shp“ (vidljiv sa lijeve strane u prozoru „Layers“). 

 
Slika 3.12 Kreiranje vektorskog poligonskog sloja  
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Želimo iscrtati poligon kojim se pokriva cijelo područje tražene dionice D8 (Crikvenica – 

Karlobag). Pritiskom na gumb „Toggle editing“omogućujemo uređivanje novo formiranog 

vektorskog sloja, te gumb „Add Polygon“ kako bi ucrtali željeni poligon. Za bolju preglednost 

radnog prozora može se ukinuti vidljivost drugih prethodno napravljenih vektorskih ili 

rasterskih slojeva (uklanjanje kvačice pored tog sloja u prozoru „Layers“).  

 

 
Slika 3.13 Prebacivanje na uređivanje poligona 
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Lijevim klikom miša i povlačenjem miša pažljivo se iscrtavaju konture poligona na način da 

se približno obilazi dionica ceste D8 od Crikvenice do Karlobaga. Na poziciji zadnje točke 

poligona dvostrukim lijevim klikom završavamo iscrtavanje poligona nakon čega se pojavljuje 

kartica „Poligon D8 – Feature Attributes“. Obzirom da mi nećemo davati nikakve atributne 

vrijednosti nacrtanom poligonu potvrđujemo radnju pritiskom na tipku OK.  

 

 
Slika 3.14 Iscrtavanje poligona oko tražene dionice ceste D8 
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Ponovno kliknemo na ikonu olovke (gumb „Toggle editing“) kako bi naznačili prekid 

uređivanja poligona te potvrđujemo da želimo pohranu unesenih promjena na poligonskom 

sloju. Ovaj poligonski sloj će nam poslužiti da napravimo ekstrakciju prethodno unesene 

podloge (vektorski linijski sloj prometnica u RH „Cestovni promet“) samo na području 

primarnog interesa. 

 

 
Slika 3.15 Spremanje poligona „poligon D8“ potrebnog za kreiranje zadanog dijela dionice 

D8 
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U nastavku želimo smanjiti područje prometnica u RH samo na područje koje je pokriveno 

prethodno napravljenim vektorskim poligonom „Poligon_D8“. To se provodi uz pomoć QGIS 

rutine „Clip“. 

Vector → Geoprocessing Tools → Clip 

 
Slika 3.16 Otvaranje alata „Clip“ 
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U polju „Input layer“ odabiremo vektorski linijski sloj „Cestovni promet“, a u polju „Overlay 

layer“ vektorski poligonski sloj „Poligon_D8“. Nakon toga stisnemo na gumb pored polja 

„Clipped“, te odaberemo „save to file“ kako bi odabrali naziv (npr „Dionica D8“) i mjesto 

pohrane datoteke u koju će se spremiti rezultati presjeka ova dva vektorska sloja. Za kraj 

kliknemo na Run. 

 

 

 
Slika 3.17 Definiranje parametara za rezanje slojeva 
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Za uočljiviji prikaz novoformiranog vektorskog linijskog sloja ponovno možemo promijeniti 

boju i debljinu sloja na način koji je već prethodno opisan. Također možemo isključiti kvačice 

nepotrebno vidljivih slojeva (npr poligona „Poligon D8“ i „Cestovni promet“). 

 

 
Slika 3.18 Uređivanje sloja “dionica D8” 
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3.2.Primjena QGIS modula „Wind effect“ 

 

U nastavku želimo iskoristiti QGIS simulacijsku rutinu sa kojom se mogu odrediti utjecaju 

orografije na intenzitet djelovanja vjetra. Rasterski sloj „EU_DEM_RH_HTRS96.tiff“ 

predstavlja podlogu za provedbu simulacije, ali prethodno želimo definirati samo onaj dio 

rasterskog sloja „EU_DEM_RH_HTRS96.tiff“ na kojem se odvija relevantni dio razvoja 

vjetrovnog djelovanja. Dakle, prvo je potrebno kreirati novi vektorski poligonski sloj za 

narednu ekstrakciju relevantnog podpodručja rasterskog sloja „EU_DEM_RH_HTRS96.tiff“. 

Rubne točke tog poligona trebaju obuhvatiti planinske lance koji se nalaze u zaobalju (vidi 

narednu sliku). Procedura kreiranja novog vektorskog poligonskog sloja je već prethodno 

objašnjena. Ovdje je za taj poligonski sloj dano ime „poligon D8 za EU_DEM.shp“. 

 

 
Slika 3.19 Kreiranje poligona za buduće rezanje („klipanje“) rastera 

Sada radimo rezanje rastera „EU_DEM_RH_HTRS96.tiff“ s prethodno kreiranim poligonom 

„poligon D8 za EU_DEM.shp“. 

Raster → Extraction → Clip raster by mask layer 

 

Za „Input Layer“ odabiremo raster „EU_DEM_RH_HTRS96.tiff“, a za „Mask layer“ vektorski 

poligon „poligon D8 za EU_DEM.shp“. Pod „Advanced parameters“ pritiskom na gumb pored 

kućice „Clipped“ otvara se mogućnost za izbor imena i mjesta pohrane novog „klipanog“ 

rastera. U ovom primjer dano je ime „EU_DEM za model vjetra na D8.tif“.  
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Slika 3.20 Rezanje („klipanje“) rastera poligonom 

Za bolju preglednost nakon ovog možemo isključiti kvačice pored 

„EU_DEM_RH_HTRS96.tiff“ i promijeniti boje za novi raster „EU_DEM za model vjetra na 

D8.tif“. 
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Sada u desnom prozoru „Processing toolbox“ upišemo naredbu „Wind effect“. Dvostrukim 

klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Elevation“ se odabire 

prethodno kreirani raster visina za analizirano podpodručje „EU_DEM za model vjetra na 

D8.tif“, u kućicu „Constant wind direction“ se upisuje vrijednost 45 (odnosno 5 ili 10 … ili 55, 

ovisno o simulaciji; stupnjevi - nautička konvencija), a u kućicu „Wind direction units“ se 

odabire „degree“. Ovime smo dali informaciju da je smjer djelovanja vjetra konstantan po 

cijelom području, odnosno da je smjer djelovanja vjetra prostorno homogen.  

 

Aktiviranjem gumba pored kućice „Wind effect“ otvara se prozor za izbor mjesta i imena 

datoteke (ovdje je dano ime „Wind effect na D8.tiff“). Završavamo sa Run.    

 
Slika 3.21 Definiranje parametara i kreiranje novog rasterskog sloja „Wind effect na D8“  



SVEUČILIŠTE U ZAGREBU 

GRAĐEVINSKI FAKULTET              DIPLOMSKI RAD 

 

 

__________________________________________________________________________________________ 

__________________________________________________________________________________ 
GRGA ALEKSIĆ 26 

Dobiveni rezultati u rasteru „Wind effect na D8.tiff“ prikazuju polje u kojem vrijednosti >1 

naznačuje pozicije lokalnog povećanja brzine vjetra a vrijednosti <1 naznačuje pozicije 

lokalnog smanjenja brzine vjetra.  Ponovno možemo promijeniti boje u prikazu rezultantnog 

rastera  „Wind effect na D8“ na već prethodno objašnjeni način (Slika 3.23). 

 
Slika 3.22 Dodavanje spektralnog izgleda „Wind effect“ sloju 

Pomoću alata „Wind effect“ kreiramo „Wind effect“ rasterske slojeve za smjer vjetra od 5, 10 

15 20 25 30 35 40 45 50 i 55 stupnjeva . 

 

Za pregled rasterskih vrijednosti potrebno je instalirati dodatak („Plugin“) pod nazivom 

„Serval“. 

 

 
Slika 3.23 Instaliranje dodatka („Plugin-a“) „Serval“  
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U nastavku trebamo prethodno kreirani vektorski linijski sloj za dionicu D8 „dionica D8.shp“ 

pretvoriti u vektorski točkasti sloj. Problem je u tome što linijski vektorski sloj „dionica 

D8.shp“ ima vrlo veliki broj točaka loma na različitim međusobnim udaljenostima uzduž linije, 

od nekoliko metara do nekoliko desetina metara. Mi smo samo zainteresirani za formiranje 

vektorskog točkastog sloja uzduž trase dionice D8 sa jednolikom međusobnom udaljenosti 

točaka („vertisisa“). To se može napraviti upisom naredbe „Points along geometry“ u desni 

prozor „Processing Toolbox“.  

 

Dvostrukim klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Elevation“ 

se odabire vektorski sloj „dionica D8.shp“, u kućicu „Distance“ se upisuje vrijednost 25 (m) 

jer je to ujedno prostorna rezolucija rastera sa rezultatima „Wind effect na D8.tiff“. 

Aktiviranjem gumba pored kućice „Interpolated points“ otvara se prozor za izbor mjesta i 

imena datoteke (ovdje je dano ime „dionica D8 na 25m.shp“). Završavamo sa Run.  

 

 
Slika 3.24 Generiranje točaka na razmaku od 25 metara duž dionice  
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S obzirom da se baziramo isključivo na državnu cestu D8 potrebno je ukloniti točke sa svih 

drugih cesta koje su preostale nakon rezanja poligonom „poligon D8“ 

U izborniku slojeva lijevim klikom miša odabiremo sloj „dionica D8 na 25 m“ te pritiskom 

na ikonu „Toggle editing“ omogućujemo uređivanje sloja. 

Zatim pritiskom na ikonu „Select features by Area or Single click“ označavamo sve točke 

koje ne pripadaju državnoj cesti D8 te pritiskom tipke „Delete“ na tipkovnici brišemo suvišne 

točke.  

 

Slika 3.25 Brisanje suvišnih točaka koje ne pripadaju državnoj cesti D8 
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Za kraj je još potrebno napraviti ekstrakciju podataka iz rastera „Wind effect na D8.tiff“ na 

mjestu točaka iz pretehodno kreiranog vektorskog točkastog sloja „dionica D8 na 25m.shp“. 

To se može napraviti upisom naredbe „Sample raster values“ u desni prozor „Processing 

Toolbox“.  

 

Dvostrukim klikom na naredbu se otvara radni prozor za upis podataka. U kućicu „Input layer“ 

se odabire točkasti vektorski sloj „dionica D8 na 25m.shp“, a u kućicu „Raster layer“ se odabire 

„Wind effect na D8.tiff“. Aktiviranjem gumba pored kućice „Sampled“ otvara se prozor za 

izbor mjesta i imena datoteke (ovdje je dano ime „ekstrakcija WIND-EFFECT po 

tockama.shp“). Završavamo sa Run.  

  
Slika 3.26 Ekstrakcija „Wind Effect“ rastera na mjesto točaka iz sloja „dionica D8 na 25m“ 
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Kreirani točkasti vektorski sloj „ekstrakcija WIND-EFFECT po tockama.shp“ potrebno je 

dodatno obraditi da se izbrišu nepotrebni atributi-kolone u „Attribute table“ (ostaviti samo 

kolonu sa vrijednostima Wind effect), te da se dodaju kolone za X i Y koordinatu u HTRS95. 

Prvo se aktivira ikona u gornjoj traci sučelja „Attribute table“, nakon toga se u novootvorenom 

prozoru aktivira ikona „Toggle editing mode“ (olovka), te ikona „delete field“. Odabiru se 

kolone koje nisu potrebne, te se pritisne OK. 

 

  
Slika 3.27 Brisanje nepotrebnih atributnih kolona sloju 

 

Postupak je ponovljen za smjerove vjetra od 5° do 55°  
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Za kreiranje novih kolona odabrati ikonu „Open field calculator“. U kućicu „Output field 

name“ upisati „X“, za „Output field type“ odabrati „Decimal number“, a u kućicu koja je u 

sredini prozora upisati „$x“. Dvostrukim klikom na „$x“ ista oznaka „$x“ se pojavljuje i u 

lijevom prozoru. Nakon potvrde akcije sa OK dobivena je jedna nova kolona u kojoj se nalaze 

X koordinate točaka u HTRS95. Ista procedura se ponavlja i za Y koordinatu. Po završetku 

pritisnemo na ikonu olovke, te potvrđujemo željene promjene sa Yes.  

 

 
 

 
Slika 3.28 i Slika 3.29 Dodavanje novih X i Y koordinata u atributne kolone sloja 
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4. REZULTATI PROVEDENIH ANALIZA 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.1 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 5° 

U slučaju smjera vjetra od 5° veliki dio točaka na dionici južno od Balinskog mosta prelazi  

izmjerenu brzinu vjetra na Balinskom mostu što ukazuje da na tom djelu dionice promet 

između naselja nije moguć.  Promet je moguć na dionicama između Crikvenice i Novog 

Vinodolskog te između Senja, Svetog Juraja i Lukovog te je na tim djelovima moguć pristup 

zaleđu. Ovo je jedini slučaj u kojem se pojavljuju kritične točke na području  Karlobaga. 

Broj točaka s većim brzinama od one na Balinskom mostu je 485 što iznosi 11.75% dionice.  
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Slika 4.2 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 10° 

U slučaju smjera vjetra od 10° povećava se broj kritičnih točaka u odnosu na smjer vjetra od 

5°. Ulaz u Crikvenicu sa sjeverne strane je onemogućen, ali je s druge strane promet omogućen 

do Klenovice. Promet je sada na području južno od Senja onemogućen osim manjeg djela oko 

Svetog Juraja i Lukovog gdje je moguć pristup unutrašnjosti preko ceste nižeg razreda. Također 

je promet omogućen na užem području oko Karlobaga isključujući mjesta Prizna i Cesarica.  

Broj točaka s većim brzinama od one na Balinskom mostu je 566 što iznosi 13.71% dionice.  
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Slika 4.3 Točke sa većim brzinama od one na Balinskom mostu pri 

smjeru vjetra od 15° 

U ovom slučaju broj kritičnih točaka nam se smanjuje u odnosu na prethodni slučaj. Promet je 

u potpunosti omogućen od Crikvenice do Klenovice. Područje sjeverno i južno od Senja je 

blokirano kao i čitava dionica južno od Balinskog mosta osim relacije Karlobag – Cesarica. 

Mali dio dionice između Svetog Jurja i Lukovog te pristup zaleđu je siguran kao i u prethodnom 

slučaju. 

Broj točaka s većim brzinama od one na Balinskom mostu je 349 što je 8.45% točaka od 

ukupnog broja točaka na dionici.  
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Slika 4.4 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 20° 

U ovom slučaju sjeverni dio dionice je siguran za promet na još malo duljem djelu u odnosu 

na prethodni slučaj (od Crikvenice do mjesta Bunica). Senj je i dalje blokiran,  kao i južni dio 

dionice od Balinskog mosta. Manja područja Karlobaga (Cesarica – Karlobag) i Svetog Jurja 

(Sveti Juraj – Lukovo) su i u ovom slučaju sigurna za promet. 

Broj točaka s većim brzinama od one na Balinskom mostu je 243 što iznosi 5.89% od ukupne 

dionice. 
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Slika 4.5 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 25° 

Raspored točaka koje premašuju  vrijednost brzine vjetra izmjerenu na Balinskom mostu je 

vrlo sličan kao u slučaju smjera vjetra od 20°. Razlika je što se prva točka ne pojavljuje 

neposredno ispod mjesta Bunica nego iznad, pa bi lokacija zatvaranja dionice iz smjera 

Crikvenice trebala biti prije ulaska u mjesto (Crikvenica – Novi Vinodolski – Klenovica). 

Promet između Senja, Svetog Jurja i Lukovog ponovno je siguran kao u slučaju smjera vjetra 

od 5°, te je područje Karlobaga  na relaciji Karlobag – Cesarica sigurno.  

Broj točaka s većim brzinama od one na Balinskom mostu je 263 što iznosi 6.37% dionice. 

  

Crikvenica 

Senj 

Stinica 

Sveti 

Juraj 

Crikvenica 

Novi 

Vinodolski 

Senj 

Stinica 

Karlobag 

Balinski 

most 

Bunica 

Lukovo 

Klenovica 

Cesarica 



SVEUČILIŠTE U ZAGREBU 

GRAĐEVINSKI FAKULTET              DIPLOMSKI RAD 

 

 

__________________________________________________________________________________________ 

__________________________________________________________________________________ 
GRGA ALEKSIĆ 37 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.6 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 30° 

Iako ovo nije slučaj s najmanjim brojem točaka čije vrijednosti premašuju brzinu vjetra od one 

na Balinskom mostu, jedini je slučaj  u kojem se ne pojavljuju točke na čitavoj dionici od 

Crikvenice preko Senja do Svetog Jurja pa bi ta dionica ceste potencijalno mogla biti otvorena. 

U ovom slučaju se kritične točke za razliku od prethodnih pojavljuju sjeverno od mjesta 

Lukovo pa bi to mjesto izgubilo povezanost sa Senjom.  

Broj točaka s većim brzinama od one na Balinskom mostu je 245 što iznosi 5.94% dionice 
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Slika 4.7 Točke sa većim brzinama od one na Balinskom mostu pri smjeru vjetra od 35° 

Ovo je slučaj s najmanjim brojem točaka koje premašuju vrijednosti od one izmjerene na 

Balinskom Mostu, ali za razliku od prethodnog slučaja mali broj kritičnih točaka se pojavljuje 

južno od mjesta Bunica te se na taj način gubi direktna povezanost Crikvenice i Senja. U ovom 

slučaju kao i u svim ostalima (osim prvog slučaja kod smjera vjetra od 5°) ) Karlobag i područje 

sjeverno od njega je sigurno do mjesta Prizna gdje se pojavljuju prve kritične točke pa je iz 

njega i dalje pristup na cestu D8 nesiguran.  

Broj točaka s većim brzinama od one na Balinskom mostu je 120 što iznosi 2.91% dionice.  
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Slika 4.8 Točke sa većim brzinama vjetra od one na Balinskom mostu pri smjeru vjetra od 

40° 

U ovom slučaju broj točaka sa većim brzinama od one na Balinskom mostu se povećava u 

odnosu na prethodni slučaj, ali raspored ostaje sličan. Jedine razlike su što se kritične točke 

pojavljuju u Crikvenici na nešto dužem području nego u slučaju kod smjera vjetra od 10° pa bi 

ona vjerojatno bila blokriana.  Kritične točke pojavljuju se sjeverno od mjesta Bunica pa bi 

promet na tom području bio moguć na relaciji Novi Vinodolski - Klenovica. Za ostatak dionice 

bi vrijedila ista pravila kao u prethodnom slučaju.   

Broj točaka s većim brzinama od one na Balinskom mostu je 431 što iznosi 10.44% dionice.  
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Slika 4.9 Točke sa većim brzinama vjetra od one na Balinskom mostu pri smjeru vjetra od 

45° 

U slučaju smjera vjetra od 45° prostorni raspored točaka s vrijednostima brzine vjetra veće od 

one izmjerene na Balinskom mostu je gotovo isti kao i u slučaju smjera vjetra od 40°. Jedina 

razlika je u tome što se kritične točke pojavljuju južno od mjesta Bunica pa u ovom slučaju bi 

promet bio siguran na toj dionici do Novog Vinodolskog . Druga malena razlika je u tome što 

se kritične točke pojavljuju južno od mjesta Lukovo pa bi promet bio siguran od Lukovog do 

Senja.  

Broj točaka s većim brzinama od one na Balinskom mostu je 436 što iznosi 10.56% dionice.  
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Slika 4.10 Točke sa većim brzinama vjetra od one na Balinskom mostu pri smjeru vjetra od 

50° 

Ovo je slučaj s daleko najvećim brojem točaka na kojima brzina vjetra premašuje onu 

izmjerenu na Balinskom mostu. Jedini je slučaj u kojem se na čitavom području Novog 

Vinodolskog pojavljuju kritične točke kao i najveća koncentracija točaka u Crikvenici. Sigurna 

su jedino uža područja oko Klenovice, Karlobaga i Svetog Juraja (u tom mjestu se u ni jednom 

slučaju ne pojavljuju kritične točke) pa bi ta mjesta potencijalno mogla imati pristup zaleđu 

preko cesta nižeg razreda.  

Broj točaka s većim brzinama od one  na Balinskom mostu je 1209 što iznosi 29.9%  dionice.  
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Slika 4.11 Točke sa većim brzinama vjetra od one na Balinskom mostu pri smjeru vjetra od 

55° 

U posljednjem promatranom slučaju pri smjeru vjetra od 55° na sjevernom djelu dionice 

pojavljuje se prva kritična točka južno od mjesta Bunica. Kao i u slučajevima smjera vjetra od 

20° i 35° moguć je promet na relaciji Crikvenica – Novi Vinodolski – Bunica. Sljedeće mjesto 

na kojem se pojavljuju kritične točke je na lokaciji sjeverno od Lukovog pa je promet moguć 

samo na relaciji Senj – Sveti Juraj. Promet je također moguć na relaciji Prizna – Karlobag jer 

je ovo jedini slučaj u kojem se kritične točke ne pojavljuju južno od mjesta Prizna.  

Broj točaka s većim brzinama od one  na Balinskom mostu je 132 što iznosi 3.20% dionice. 
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Ukupan broj generiranih točaka na međusobnom razmaku od 25 metara na čitavoj dionici je 

4128. U nastavku je tablično i grafički prikazan relativni odnos ukupnog broja generiranih 

točaka i broj točaka sa većim brzinama od reprezentativne točke za svaki pojedinačni slučaj 

smjera vjetra.   

Tablica 1. Prikaz broja kritičnih točaka za različite smjerove vjetra 

Smjer 
vjetra 

Broj točaka većih 
brzina od 

reprezentativne točke 

Postotak u 
odnosu na 

ukupnu duljinu 
dionice 

0° 818 19.82% 

5° 485 11.75% 

10° 566 13.71% 

15° 349 8.45% 

20° 243 5.89% 

25° 263 6.37% 

30° 245 5.94% 

35° 120 2.91% 

40° 431 10.44% 

45° 436 10.56% 

50° 1209 29.29% 

55° 132 3.20% 

 

 

Slika 4.12 Histogram relativnog odnosa ukupnog broja točaka na dionici i kritičnih točaka 

za različite smjerove vjetra  
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5. ZAKLJUČAK 

Analiza rezultata dobivenih korištenjem “Wind effect” modula u QGIS softveru za različite 

smjerove vjetra otkriva raznoliku distribuciju točaka s većim brzinama od referente točke na 

Balinskom mostu. Broj tih kritičnih točaka varira značajno, s minimalnih 120 do maksimalnih 

1209, ovisno o smjeru vjetra. Čak i pri maksimalnom broju takvih točaka, uočavaju se dijelovi 

dionice koji potencijalno ne bi predstavljali ozbiljnu prijetnju za promet.  

U slučajevima s manjim  brojem kritičnih točaka, primjećuje se da bi velike poddionice 

potencionalno mogle ostati otvorene za promet. Dakle prema provedenoj “Wind effect” analizi  

zatvaranje čitave dionice od Novog Vinodolskog do Karlobaga nije nužno opravdano.  

Također, neki segmenti na dionici izdvajaju se visokom koncentracijom kritičnih točaka za 

svaki smjer vjetra. Primjerice, sjeverno od Stinice na segmentu od kamenog luka do samog 

naselja Vlaka u duljinu od otprilike jedan i pol kilometar, te sjeverno od izlaza s državne ceste 

D8 za trajektno pristanište Prizma, u području starog groblja Prizna i izlaza za naselje Lomivrat 

u duljini nešto manjoj od kilometar. Na tim segmentima bi se mogla napraviti dodatna 

razmatranja i analize za eventualnu zaštitu vozila od vjetra u obliku vjetrobrana. 

Međutim, treba uzeti u obzir da modul “Wind effect” radi na način tako da uzima homogeni 

smjer djelovanja vjetra te prikaz polja s relativnim odnosima brzina vjetra u obliku lokalnog 

povećanja ili smanjenja koja se javljaju s obzirom na smjer vjetra i topografiju terena čiji su 

podaci zapisani u obliku digitalnog elevacijskog modela (DEM). Mnoge druge fizikalne 

karakteristike vjetra ne analizira u usporedbi s numeričkim atmosferskim modelima kao što je 

Aladin-Hr. 

Dakle, primjena GIS modela ima prednosti kao što su vrlo velika preglednost zahvaljujući 

visokoj rezoluciji, vrlo detaljna topografska podloga, jednostavnost, pristupačnost i  mogućnost 

prilagodbe vizualnog pregleda podataka. Stoga bi primjena GIS-a u budućnosti mogla uvelike 

pridonjeti razvoju prikazivanja djelovanja vjetra na uvjete prometa.  
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